Kofax Capture Overview

• Use this module to perform a comprehensive review of the course.

Kofax Inc.

• Kofax Inc. is the leading provider of document driven business process automation solutions.
• Streamlines the flow of information throughout an organization by managing the capture, transformation and exchange of business critical information arising in paper, fax and electronic formats in a more accurate, timely and cost effective manner.
• Solutions provide a rapid return on investment to thousands of customers in financial services, government, business process outsourcing, healthcare, supply chain and other markets.
The Solution: Kofax Capture

- **Kofax Capture**
  
  A batch-oriented document capture application designed to accelerate business processes by collecting documents and forms, transforming them into accurate, retrievable information, and delivering it to business applications and databases on a local or wide area network or the Internet.

- Capturing documents from different sources (scan, import, e-mail...) and locations (LAN, WAN, the Internet...).
- Processing all document types associated with a business process.
- Processing workflow is established inside Kofax Capture based on a repeatable, auditible process.
- Kofax Capture enhances business process automation by increasing accuracy and throughput and reducing manual processing.

Document Capture Feeding Your Enterprise

- **Document Capture**
- **Processing**
  - Performs automated image separation and conversion, data extraction and document conversion.
- **Delivery**
  - Converts files to numerous backends in a single process.
- **Data**
  - Data is available on the enterprise.
- **Documents & Data**
  - Documents and data become part of the business process.

The Production Capture Process

- **Document Preparation**
- **Scan**
- **Recognition**
- **Validation**
- **Review Images**
- **OCR/ICR/OMR**
- **Read Bar Codes**
- **Database Validation**
- **Scripting**
- **Export**
- **Correction**
- **PDF Generator**
- **PDF Generator**
- **Create PDF**
- **Create PDF and OCR Full Text Files**
- **Archive Images**
- **Output PDF**
- **Quality Control / Re-Scan**
Module 19 -- Kofax Capture Review

Defined and Repeatable Capture Process

- "Workflow" within Kofax Capture defined by **batch classes**.
- Batch classes define workflow via **queues** (queues = modules).
- Examples of queues (modules): Scan, Recognition Server, Validation, Verification, and Export.

Example:
- Scan operator creates batches based on batch classes.
- Batches are processed in production through the queues.
- Structure and flow is auditable and repeatable.

Kofax Capture Workflow

- In the production/operations phase, every workflow begins with the Scan function and concludes with the Export module.
- Workflow is configurable.
- Workflow can include standard Kofax Capture queues, custom modules, or Kofax add-ins such as Kofax Transformation Modules (KTM).
- Reach and functionality of Kofax Capture can be expanded through the addition of "extensions" (Kofax Capture Network Server, Kofax Front Office Server, and Kofax Capture Import Connectors).
- Documents can be captured and processed globally through a variety of input capture modes.

Kofax Capture on the Network

A "typical" client/server deployment of Kofax Capture
Document Capture Concepts

- **Classification (Form ID)** – Distinguishing between different Document Types and Form Types.
- **Separation** – Creating boundaries between individual documents in a batch. Documents may be single-page or multi-page.
- **Extraction** – The process of automatically lifting data from a document using rules or zones along with the output from a recognition engine (OCR, OMR, barcode, etc). This data usually is output to a database or document management application for later retrieval.

Registration – a Definition

Registration is the alignment or calibration of a page being imported or scanned to its sample page. Registration helps to assure that zones line-up with the goal of enhancing the accuracy of optical recognition operations. Registration can be enhanced by one or more Registration Zones as we’ll see in a future module.

Image Clean-up Technology

- Zonal or full page based
  - Image Cleanup
    - Black border removal
    - Deskew
    - Deshade
    - Despeckle
    - Destreak
    - Horizontal and Vertical Line removal
    - Character reconstruction
    - Edge Enhancement Filters
    - Smooth, thicken, thin, fill in lines, etc.
Recognition and Extraction Capabilities

- Form ID – Distinguishing between different document types and form types
- Page registration – Aligning pages for enhanced extraction accuracy
- Patch code detection – Detecting patch codes
- Bar code recognition – Detecting and reading bar codes
- Optical Character Recognition (OCR) – Reading machine printed characters
- Intelligent Character Recognition (ICR) – Reading hand printed characters
- Optical Mark Recognition (OMR) – Determining the status of checkboxes

Levels of Definition in Kofax Capture

- **Batch Class**
  - Properties for processing a Batch
- **Document Class**
  - Properties for types of documents
- **Form Type**
  - Properties for a specific form or document
- **Folder Class**
  - Structure to match back-end applications
- **Field Type**
  - Types and sizes of data to be captured

Batch Class

A “Batch Class” is the highest level of definition. At this level, you’ll define how you’re going to process the batch, including:
- The workflow of the batch through the processing queues
- The method by which the batch will be separated into individual documents
A Document Class is the second level of definition used to associate the same group of fields and processing settings for a single form type or multiple form types. Every Batch Class must have one or more Document Classes attached to it. This is the level we set up and define index fields, document conversion (PDF and OCR Full Text), and database validation.

A Form Type defines properties for a specific form or document that will be processed in Kofax. Form Types belong to Document Classes, and every Document Class must have at least one.

A Folder Class is an additional level inside Kofax that allows you to match the structure of your document management application. A Folder Class is attached to a Batch Class. Multiple levels of folders are allowed and may be nested.
A Field Type is a SQL Data Type template that sets the rules for what kind and size of data a Field will hold. These are shared among Batch Class, Document Class and Folder Class fields.

Kofax Capture Hierarchy

The Production Workflow Process

All processing is done inside Kofax Capture through a series of out-of-the-box modules (queues), custom modules, or add-on Kofax products (such as KTM).
Module 19 -- Kofax Capture Review

Kofax Capture Licensing

<table>
<thead>
<tr>
<th>Kofax Capture Licenses</th>
<th>System</th>
<th>Station</th>
<th>Volume</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Standard</td>
<td>Station</td>
<td>Volume</td>
<td>Other</td>
</tr>
<tr>
<td></td>
<td>Enterprise</td>
<td>Station</td>
<td>Volume</td>
<td>Other</td>
</tr>
<tr>
<td></td>
<td>Evaluation Suite</td>
<td>Station</td>
<td>Volume</td>
<td>Other</td>
</tr>
</tbody>
</table>

- **Scan/Import**
- **Volume**
- **Page Count**
- **Enhanced Bar Code (EBC)**

* Applies to Kofax PDF Text Under Image format as well.

System Licenses

- A system license enables features or sets limitations shared by the entire Kofax Capture system
  - **Standard**
    - Applies to a server and all connected workstations
    - Specific to the Kofax major release version (10.X)
  - **Enterprise**
    - Supports the following features:
      - Backup license server
      - High Availability Support
      - Disaster Recovery Support
      - SQL Server Enterprise, Oracle, and IBM DB2 Support
      - Multiple Instance Support
      - Terminal Services and Citrix Support
      - WebSphere Support and remote site export (KCNS)
      - SNMP Monitoring
  - **Evaluation Suite**
    - Limited by time and volume

Station Licenses

- **Concurrent Station**
  - Equivalent to the previous Full Station functions
  - Required for any station capturing or manipulating images
- **Stand alone Station**
  - For stand alone systems only – not for use in a client-server environment
  - Stand alone Stations include 60k annual volume
### Concurrent and Stand Alone Station Licenses

- Allows processing using these queues (modules):
  - Scan (Note – Scan also requires a Scan/Import Volume license):
    - Scanning
    - Software import
    - Import scripts
    - Import connectors
    - Import of eDocuments
  - OCR Full Text
  - PDF Generator
  - Quality Control
  - Recognition Server
  - Export
  - Validation
  - Verification
  - Custom modules (based on the Custom Standard Module only)

### Scan/Import Volume

- **Scan/Import Annual**
  - Decrement by a count of 1 for each image scanned or imported
  - Annual Only – determines annual throughput or usage
  - Refreshes at the beginning of the year
- **Scan/Import Page Count**
  - Decrement by a count of 1 for each image scanned or imported
  - Based on a fixed volume – can be used as reserve
  - When the count is exhausted, the license is done

---

Unused Annual volume at the conclusion of a license period is not carried forward.

At least one Annual volume license must be present before a Page Count license can be exercised.

### Licensing for PDF Options

- **Kofax PDF Image + Text Annual**
  - Decrement by a count of 1 for each page (image) converted
  - Annual Only – determines annual throughput or usage
  - Refreshes at the beginning of the year
- **Kofax PDF Image + Text Page Count**
  - Decrement by a count of 1 for each page (image) converted
  - Based on a fixed volume – can be used as reserve
  - When the count is exhausted, the license is done
- **PDF Compression Annual**
  - Decrement by a count of 1 for each page (image) compressed
  - Annual Only – determines annual throughput or usage
  - Refreshes at the beginning of the year
- **PDF Compression Page Count**
  - Decrement by a count of 1 for each page (image) compressed
  - Based on volume, can be used as reserve
  - When the count is exhausted, the license is done
Virtual ReScan Licensing

- A Basic (minimum) license is required to enable Virtual ReScan (VRS).
- A VRS Professional license allows you to run:
  - Automatic color detection
  - Background smoothing
  - Content-based rotation
  - White background cropping and deskew
  - VRS QC Later
- Three types of VRS Professional licenses:
  - Desktop – DOES NOT SUPPORT VRS QC LATER
  - Workgroup – supports all Professional features
  - Production – supports all Professional features

VRS Professional Licenses

- The VRS Professional licenses are categorized based on support of feature sets and scanner throughput (pages per minute or ppm) as follows:
  - Desktop – Supports VRS Professional features for certified scanners with throughput up to approximately 35 ppm
  - Workgroup – Supports VRS Professional features for certified scanners with throughput from approximately 35 to 90 ppm
  - Production – Same as VRS Workgroup with additional support for scanner throughput that typically exceeds 90 ppm
- Refer to the Scanner Configurator on the Kofax Web site (www.kofax.com/support/configurator) for more information relating to specific makes and models of scanners.

Enhanced Bar Code (EBC) License

- Enhanced Bar Code (EBC)
  - Allows reading bar codes directly from color images
  - Color bar code processing at scan resolutions as low as 100 dots per inch (DPI)
  - Support for one- and two-dimensional (2-D) bar code types from color, grayscale, or bitonal images
  - Not required when using VRS with a Professional license if performing the operation at scan time
No License Required

- A license is not required to run these modules:
  - Kofax Administration
  - Batch Manager
  - Database Utility
  - Separator Sheet Utility
  - License Utility
  - Remote Synchronization Agent
  - Help
  - Report Viewer
  - Scanner Configuration Utility
  - API Reference Guide

Deployment Options

- There are a number of ways that Kofax Capture can be deployed:
  - Installation media or ISO file download
  - Network (for client/server installations)
  - Kofax Capture Deployment Utility
  - Windows Installer (MSI)

Configure the Database

To use an alternate database from the standard: First install your database and create an empty schema (in most cases). Then, at Kofax Capture installation, be connected to the database and select the appropriate radio button for the desired database.

Remember: A Kofax Capture Enterprise System license is required when using SQL Server Enterprise, Oracle, or IBM DB2.
Installing in a Client/Server Environment

- When installing in a client/server environment, install Kofax Capture on the server first, then on each client workstation.
- Installation on the server is almost identical to the instructions for a standalone with some exceptions.

Installing on a Client Workstation

- From each workstation, connect to the share CaptureSV and the WrkInst folder on the Kofax file server and run Setup.exe

Thresholding

- Thresholding: The percentage of black pixels deleted for the conversion of a multi-bit grayscale or color image into a single bit/pixel, binary black and white image.
Module 19 -- Kofax Capture Review

Thresholding Results

- This concept of simple thresholding results in a compromise.
- At any threshold level, there is always some content sacrificed.
- Kofax Capture and Kofax VRS provide thresholding technology that preserves the highest percentage of original content with minimal compromises.

Introduction to Kofax VirtualReScan (VRS)

- Kofax VirtualReScan (VRS) is image enhancement technology providing:
  - The best quality images
  - With minimum effort
  - Representing all the content of the original
  - With the smallest file size possible
- Kofax VRS is an agent
  - Watching the status of the scanner (out of paper, paper jam, connection, etc.) and guiding the end user to resolve hardware issues.
  - Checking image quality continuously.
- Kofax VRS 5.1 is silently installed with Kofax Capture

The Kofax VRS Process

- Batch is scanned using Kofax VRS source scanner.
- Kofax VRS creates a multi-bit per pixel image (8-bit grayscale or 24-bit color).
- Kofax VRS performs image clean up and enhancement on the multi-bit image.
- Kofax VRS performs thresholding, converting the multi-bit image to a 1-bit per pixel bitonal TIFF image.
- 1-bit per pixel bitonal TIFF image is made available for further processing.
Module 19 -- Kofax Capture Review

VRS QC Later

- Allows operators to correct an image without having to physically rescan the document
- When a page does NOT fall within the predefined image limits, then the master image (8-bit grayscale or 24-bit color) is linked to the page
- VRS QC Later may be activated to display the Kofax VRS Interactive Viewer for correcting the image

Requirements for VRS QC Later

- Three requirements exist for using VRS QC Later with Kofax Capture:
  1. A software VRS Source (SVRS) must be selected at scan time
  2. Must have a VRS Professional license (either Workgroup or Production)
  3. Must select "QC Later" as the Adjust Quality mode in the Scan module

The VRS QC Later Process

- Batch is scanned using Kofax VRS source scanner.
- Kofax VRS creates a multi-bit per pixel image (8-bit grayscale or 24-bit color).
- Kofax VRS performs image cleanup and manipulation on the multi-bit image.
- Kofax VRS performs thresholding, converting the multi-bit image to a 1-bit per pixel bitonal TIFF image.
- The QC operator opens the Kofax VRS Interactive Viewer and fixes the multi-bit grayscale or color image.
Module 19 -- Kofax Capture Review

### Scanner Properties and Profiles

- **Source Properties** provide parameters for continued use after being setup once
  - Scan resolution (examples: 100, 200, 300 dots per inch [dpi])
  - Paper size (examples: legal, letter, A4)
  - Blank Page Thresholds
  - Color modes (color or black-and-white scanning)
  - Orientation (landscape versus portrait)
  - Simplex versus duplex mode
  - Advanced properties
- **Scanner Profiles** provide parameters for attached scanners
  - Scanner settings are defined once
  - Profiles can be selected from an available list
  - Scanners may have multiple profiles for added flexibility

### Set the Source Properties

Source Properties change based on the scanner installed

<table>
<thead>
<tr>
<th>Source Properties</th>
<th>Legal 6.5 x 9.5 / Legal 6.5 x 9.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>ASP</td>
</tr>
<tr>
<td>Destination</td>
<td>Fax</td>
</tr>
<tr>
<td>Resolution [dpi]</td>
<td>300</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Letter</td>
</tr>
<tr>
<td>Orientation</td>
<td>Portrait</td>
</tr>
<tr>
<td>Source Side</td>
<td>Single Sheet, Optional Sheet</td>
</tr>
<tr>
<td>Output Side</td>
<td>Manual Start</td>
</tr>
<tr>
<td>Simplex/Duplex</td>
<td>Single-Sided, Double-Sided</td>
</tr>
<tr>
<td>Scan Start [sec]</td>
<td>16</td>
</tr>
</tbody>
</table>

Select [Options] to review or define scanner options

### Advanced Options – the VRS Interactive Viewer

The [Advanced] button launches the Kofax VRS Interactive Viewer for configuring VRS-related scan settings.
Save Scan Settings as a Scanner Profile

- A scanner profile saves all the properties set-up for the scanner.
- Click (OK) to save the profile.
- Click on [Save] to launch the "Save Scanner Profile" window.
- Give a name to the scanner profile.

Naming and Loading Scanner Profiles

- Normally, when a batch is opened in the Scan module, Kofax Capture searches for and loads scan profiles in the following order:
  1. Looks for a profile with the same name as the batch class for that batch.
  2. If there is none, then looks for a profile called "Default".
  3. If there is none, then leaves the existing profile in place (if any) or defaults to the default settings of the scanner.
- Therefore, if specific settings for a batch are desired to load automatically at scan time, create a scan profile with the same name as the associated batch class.

Centralized Scanner Configuration

- Once created, scanner profiles can be shared over the entire Kofax Capture network in a client-server deployment.
- When setting the profile at one client station, an option is provided to save the profile to the Kofax Capture server.
- All other clients logged-in can access that profile.
**Module 19 -- Kofax Capture Review**

**Administration Module Interface**
- Kofax Button
- Ribbon
- Quick Access Toolbar
- Title Bar
- Source Panel
- Definitions Panel
- View Panel
- Zoom Group

**Changing Color Scheme and Language**
- Left mouse click on [Options] to change the color scheme and language

**Selecting a Language**
- Select a language from the dropdown and click [OK]
- The "Windows display language" option selects the OS Language. If an OS Language Pack/Multilingual User Interface is installed and the regional settings are configured it will use the configured settings.
Let's look at a definition of “Separation” and “Form Identification.”

Kofax Capture offers six separation methods. Five provide fully automated separation and are easy to setup. Each method can be further customized to fit separation and form identification requirements.

The first five represent “scan time” separation methods, meaning the batch must be separated by the time it is closed in the Scan module. Kofax page recognition accomplishes separation in the Recognition module.

Separation Defined

• Separation sets the boundaries of a document and determines when a new document is created within the batch.

When a batch is scanned or otherwise captured, it is brought into the system as discrete images. By the conclusion of processing within the Kofax Capture workflow, all images must become part of a document – no orphaned images are allowed in the batch.

Form Identification (Classification) Defined

• Form Identification (Classification) is the process of matching each separated document with a form type in the batch class.

With Kofax Capture, a variety of techniques are available to identify forms including: page-level recognition, separator sheets, or form ID zones. (We will learn more about these methods in this course.)
Separation & Classification in the Kofax Capture Workflow

- Unprocessed Batch
- Document Separation
  - Separated Documents
  - Form Identification
- Separated and Classified Documents (no orphaned images are allowed)

Form Identification: Topology-based

An analysis of the sample page on a pixel-by-pixel basis results in a histogram.

The histogram becomes a “fingerprint” for the sample page.

When documents are scanned, Kofax Capture compares them to the sample page(s) and tries to match the “fingerprints” using two criteria: Confidence and Difference.

Custom Separation and Form Identification Profiles

- All of the out-of-the-box Separation and Form ID profiles are customizable.
- Examples might include separation scenarios based on patch codes or bar codes:
  - The standard profiles assume the patch code or bar code is on a separate separator page in the batch.
  - The code is used for separation and the separator page is automatically deleted by Kofax Capture at scan time.
  - If the code is on the first page of the document, that page will be deleted from the document (an unwanted deletion).
  - The existing profile can be modified to retain that page containing the separation patch code or bar code.
  - The existing profile is selected from the custom dropdown window, modified, and saved as a new custom profile (being added to the pool of profiles available).
Creating a Custom Separation and Form ID Profile

Custom Separation and Form Identification profiles can be created for a variety of specialized reasons by modifying an existing profile.

1. Select [Custom]
2. Select a profile to be modified
3. Click [Edit Profile]

Advanced Batch Class Properties

- Partial Batch Export
- Sorting options
- eDocuments
- File import conversion
- Re-scanning options
- Color cleanup options
- Single document processing and routing

Sample Pages

- Kofax Capture uses template-based extraction.
- Elements (for example, data to be extracted) on structured documents is consistently located in the same location.
- A template that closely approximates the pages being input or scanned in production can be utilized to define all the actions Kofax Capture needs to perform in production.
- A sample page is a template.
- Administrators use sample pages in the Administration module to define the specific locations (via zones), the activities to be performed, and the technology to be used by Kofax Capture.
Requirements and Guidelines for Sample Pages

- A sample page is required when:
  - Setting automatic form identification
  - Defining zones for indexing, recognition, registration, or separation
  - Setting page-level barcodes

- Requirements/guidelines for creating a sample page include:
  - Input using same make/model of scanner as used in production
  - Input using same resolution (dpi) as used in production
  - Must have same number of pages as production documents
  - Must be a TIF file – no eDocuments

The Sample Page is Ready for Setup

A sample page icon is attached to the form type. When expanded, place holders for zones are visible.

Create a Field Type

Create a new field type in one of three ways:
1. Click on the Field Type icon in the Quick Access Tool Bar
2. Right mouse click in the Definitions Panel | Field Types tab and select “New Field Type...”
3. Click on “Field Type” icon on the Insert panel
Field Type Properties

- Assign a Name
- Assign an optional Description
- Choose one of the 11 SQL data types
- Subtypes are available for Email and Fax
- Assign maximum number of characters
- Click [Save] when field type settings are complete

Index (or Data) Field Settings

- Overtype “Name0” with the index field name
- Enter a different value for Display Label if the label viewed by the Validation and Verification operators is to be different than the field name
- Select from the dropdown for Field Type
- (We’ll discuss the other settings in later training modules)

Setting Index Field Attributes

- Values are toggled “True” or “False”
- Required TRUE: Field must have a value
- Verify TRUE: Field will be reviewed in Verification
- Hidden TRUE: Field Name & Value hidden from operators
- Sticky TRUE: Field value sticks until changed
- Total TRUE: Total required when batch created (more on this later)
**Zone Types**

- Multiple zone types are available for defining locations and activities to be performed by Kofax Capture in production. Zones are selected and configured from the Insert tab and include:
  - Data or Index
  - Text Registration
  - Shape Registration
  - Separator
  - Form Identification
  - Group Zones

---

**Choose the Index Zone Icon**

Select the "Index Zone" icon from the Insert tab.

---

**Draw the Zone and Configure the Properties**

With the left mouse button depressed, draw a box around the element. Leave extra room on the right to accommodate longer values than the sample. Release the mouse button. When the Create Index Zone window appears, select the associated field from the dropdown. Click [OK] to complete the setup.
Kofax Recognition Profiles

- Recognition profiles allow setting the properties for optical recognition operations (OCR, OMR, ICR, Bar Code, PDF, OCR Full Text) on a page or zonal basis.
- Kofax-supplied profiles can be used as-is, or they can be modified and saved to a new custom profile. (We’ll discuss modifying recognition profiles in a later module.)

Recognition Profile Elements

Recognition profiles are a function of three elements:

- The optical recognition engine/technology
- The settings for that engine
- Optional image cleanup operations

Image Cleanup Profiles

- Every recognition profile may use an image cleanup profile.
- This image cleanup is applied to the individual zone using the recognition profile, therefore the changes are temporary and do not affect the image output at export.
- Zonal image cleanup increases accuracy for automatic recognition.
- Image cleanup profiles propagate upward and can be shared by recognition profiles.
Database Validation

- Any ODBC compliant database may be used to provide data from tables and columns to be entered into index fields
- The setup is done on a document class level
- A database is selected, read access is required
- A field value is used to provide the key match (foreign key)
- A table is selected in the database for data retrieval
- A column is selected from the table to match the foreign key value from the Kofax Capture field
- Trigger timing is set
- Multiple match behavior is set

Document Class – Select Database Validation

Right mouse click on the document class and select "Database Validation"

Using Batch Manager

- Batch Manager is the operations center for Kofax Capture
- Batches in-process are listed
- Clicking on a column heading re-orders the list of batches in-process
- Batches are managed
  - Create batches
  - Process batches
  - Review batch history
  - Change batch Priority
  - Change batch Status
  - Route batches – change Queue
Module 19 -- Kofax Capture Review

Batch Manager – Batch List

All active batches are displayed. Simply click on a column heading to reorder the list based on that attribute.

Batch Filtering

Check the [Filter Panel] checkbox to display the filter options.

Enable filtering

Select the filter criteria

Batch Class Update for Batches In-process

- There are times when batches have been created and something in the batch class is no longer valid.

- The Batch Class Update feature allows the administrator to correct and republish the batch class, and then update the batches in-process with the latest batch class definition.

- For example, you may be validating a batch and realize that you wanted database validation. You can suspend the batch in Validation, add database validation to the batch class in the Administration module, and then apply that change to the batch(es) in-process.
Batch Class Update Procedure in Batch Manager

- From the Batch Manager, select one or more batches that are to be updated with the latest version of the source batch class and select [Batch Class Update] from the Home tab.

Scanning/Importing the Batch

To initiate scanning or importing, use the Scan Page or Scan Batch icons.

Pages are scanned and appear in the View panel. The batch appears in the Batch Contents panel as well.

Validation Module Options

Left mouse click on the Kofax Button to expose the menu items.

Left mouse click on [Options] provides for settings designed to enhance the Validation operators’ productivity and accuracy.

NOTE: The Tab key is the default termination key.
Lock Toolbars and Restore Defaults

Lock Toolbars and Restore Defaults features provide a convenient way to lock all docked toolbars and panels in place, and to recover them if undocked and lost.

Processing the Batch in Verification

The Verification module offers settings similar to those available in the Validation module for making the operator more efficient and results more accurate.

Ordered By:
Peter York
74 Adams Drive
Meadow City, CO
32450

Correcting Mismatch of Data – Attaining High Accuracy

In the case of a mismatch between the Validation and Verification-based values, the operator is prompted with a data mismatch reconciliation window.

If the Blind Data option was left on, the Verification operator is forced to manually key-in data in all the fields, increasing the probability of a high degree of accuracy.
Running Recognition Server

The Recognition Server runs as an unattended queue. Additional image cleanup may be performed as well as registration and extraction operations.

Required Steps for OCR Full Text Setup

- There are three required steps for setting up OCR Full Text within the Administration module:
  1. Add OCR Full Text to the batch class workflow (Batch Class properties, Queues tab)
  2. Set the properties for OCR Full Text (Document Class, OCR tab)
  3. Export the OCR Full Text-generated documents (export connector)

Required Steps for PDF File Conversion Setup

- There are three required steps for setting up PDF file conversion within the Administration Module:
  1. Add PDF Generator to the batch class workflow (Batch Class, Queues tab)
  2. Set the properties for PDF generation (Document Class, PDF tab)
  3. Export the PDF documents (export connector)
Image Compression Profile Settings

When configuring a PDF profile, PDF Compression can be configured using an Image Compression profile.

Remember: PDF Compression requires additional licensing.

PDF/A Support

- Preserves visual appearance over time.
- Independent of tools & systems used for creating or storing.
- 100% self-contained – all necessary information for reproducing the file is embedded.
- Is available for both the PDF Image-only and PDF Image + Text formats.

Select between Standard PDF and PDF/A output formats.

Quality Control Queue

- Similar to the Scan queue
- Requires a Station license
- Additional functions available
- May be part of the Kofax Capture workflow (Explicit queue)
- Might only be used to correct problems (Exception queue)
- Documents or pages may be:
  - Unrejected, Rejected, Replaced or Inserted in a Batch
  - Single or multiple pages may be viewed
  - VRS QC Later allows the image to be corrected outside the Scan queue
Module 19 -- Kofax Capture Review

**Run the Export Module**

The Export module is run at the conclusion of the workflow processing.

**User Profiles**

- Allows creation of users and groups within the Administration module
- Users and groups can be restricted to:
  - Specific batch classes
  - Specific modules
- Supports password-protected login to Kofax Capture modules
- Allows user tracking (batches processed, total time in module, keystrokes, productivity...)

**Groups and Users**

First, we'll create a couple of groups.

Then we grant rights to specific processing modules and to specific batch classes.

Then we create users and assign them to groups.

Members inherit the rights of the group. Group rights cannot be removed from a member, but additional ones can be granted.

---

Kofax Technical Training
Enable User Profiles

- Click on [Enable User Profiles]
- Click on the Profiles icon from the Tools tab to launch the User Profiles window
- By default, (Everyone) has rights to everything
- The (Everyone) group cannot be removed, but (Everyone)'s rights to everything CAN be disabled

Single Sign On

- Users and groups may be linked to the operating system login.
- When a user logs into Windows, a second login is not required to launch Kofax Capture modules.
- Quickly and easily configure domain users and groups for Single Sign on when configuring user profiles inside Kofax Capture.
- Uses Microsoft Active Directory dialogue.

The Linked User or Group Needs to be Edited

- Once present inside Kofax Capture, the linked user or group must be edited to assign rights.
- Select [Edit] to give the linked user or group permissions within Kofax Capture.
Module 19 -- Kofax Capture Review

**Turnkey Reports**

- Kofax Capture provides several reports that help track system and operator status and performance.
- Kofax Capture Report Viewer module (based on Crystal Reports) does not require any third-party software to run or view any of the reports.
- All necessary components are available on the Kofax Capture media.
- No special license required to run the report viewer.
- Reports can be generated, viewed, printed, and exported.
- User Tracking must be enabled in Kofax Capture.
- Reports are included as .rpt files in the Reports directory: Program Files(x86)/Kofax/Capture/Bin/Reports

**DBUtil Interface**

- Database tab provides for the switching between the databases supported by Kofax Capture.
- SecurityBoost tab allows the Security Boost User and properties to be setup.
- Identification tab provides access to the installation setup. The Site Name, Site ID and Station ID may be changed here.
- Batch Information Editor tab allows batches in progress to be viewed. Values and release setup may be changed for batches in-process.
- Repair and Compact tab provides several options for repairing or compacting the Kofax Capture databases.

**Customizing Kofax Capture**

- In addition to the standard “out of the box” features, Kofax Capture can be customized to better suit unique and varied capture requirements.
- Reasons why Kofax Capture might be customized include:
  - Streamline or bypass unnecessary operations
  - Insert additional processes into the workflow or modify the operation of a workflow step
  - Customize the user interface
- Customization is enhanced through a variety of Kofax-supplied tools and code samples (many of these in the form of source code).

Learn more details on how to customize Kofax Capture and get hands-on experience through the Customizing Kofax Capture course.
Options for Customizing Kofax Capture

- Custom Scripting
  - Softbridge Basic Language (SBL) scripts for field type macros, recognition scripts, validation scripts, and folder scripts
  - VB.NET scripting
  - Export connectors
- Custom Elements
  - Uses ActiveX Controls to change Scan, QC, Validation and Verification
- Custom Extensions
  - Setup OCXs
  - Custom modules
  - Workflow agents

Development Environment Support

- Kofax Capture supports the following development languages for export and import connectors, custom modules, workflow agents, and OCX panels:
- For validation and recognition scripts and field macros:
  - Softbridge Basic Language (SBL) 5.3

Browser-based Deployment Setup

- Steps to setup browser-based deployment include:
  1. Create a fully accessible folder.
  2. Create a virtual directory in IIS that links to the folder.
  3. Copy all contents from the KCWebDeploy folder on the Kofax Capture media to the virtual directory folder.
  4. Configure MIME types (required only if running on IIS 6).
  5. Navigate to the virtual directory folder and run the setup (setup.exe and KCWebDeploy.exe).
  6. Modify how Kofax Capture is to be deployed (optional).
Future Applications for Browser-based Deployment

- Browser-based deployment offers the following advantages to current and future versions of Kofax Capture:
  - Browser-based deployment of the application
  - Browser-based launch of Kofax Capture modules
  - Automatic browser-based deployment of updates (upgrades, patches and fix packs)
  - Browser-based customization deployment

Exporting and Importing Batch Classes

- With Kofax Capture, batch classes can be exported as cabinet files (a very efficient compressed file with a "cab" extension).
- Cabinet files give batch classes "legs", allowing them to be transported from machine to machine (between environments, such as from development to production).
- Cabinet files can also play a role in batch class backup for security purposes.
- When a batch class is saved as a cabinet file, all underlying components of that batch class are stored and transportable as part of the batch class.
- Single or multiple batch classes can be stored in a single cabinet file.
- No special software or licenses are required to create a cabinet file and it is done via the Administration module.

Good Practices for Capture-enabled Form Design

- Guidelines for character construction for improving ICR accuracy
- Form identification for Form ID and Document Separation
- Registration points for image registration
- Combed fields to improve ICR extraction
- Open space around data fields and fade-out ink
- Also remember what we learned about OMR processing when designing check boxes
Good luck on the Certification Exam!